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Notes to Readers
The DeviceNet Configurator User Guide provides the following
information:

• Installing and operating the DeviceNet Configurator.

• Configuring communications between the 2716D master module and
the Configurator.

• Offline configuration - creating a configuration file from EDS files;
creating links; mapping I/O points; setting parameters; building
explicit messages.

• DeviceNet Monitor - general description of the Monitor interface
and how to build a configuration file by using an active network
connection.

Related Documents
The following documents contain additional information:

• For information on Quickstep, refer to the QuickstepTM

Language and Programming Guide or the QuickstepTM User Guide.

• For information on your controller and its modules, refer to the
appropriate Installation and Applications Guide.

• For information on on the registers in your controller, refer to the
Register Reference Guide.

• For information on Microsoft Windows or your PC, refer to the
manuals provided by the vendor.

• For information on the 2716D, refer to the 2716D DeviceNet
Module Installation Guide.
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Notes to Readers

Book Conventions
The following conventions are used in this book:

ALL CAPS BOLDFACE Identifies DOS, Windows, installation program file names.

Boldface Indicates information you must enter, an action you must
perform, or a selection you can make on a dialog box or
menu.

Italics Indicates a word requiring an appropriate substitution.
For example, replace filename with an actual file name.

Text_Connected_With_Underlines Indicates symbolic names used in Quickstep programs.
Step Names are ALL_CAPITALS.  Other symbolic names
can be Initial_Capitals or lower_case.

SMALL CAPS Identifies the names of Quickstep instructions in text.

Courier font Identifies step names, comments, output changes, and
Quickstep instructions appearing in the Quickstep editor.

Art Code Identifies the file name of a particular graphic image.

How to Contact Control Technology Corporation
Control Technology Corporation is located in Massachusetts, and we are
open from 8:30 a.m. to 5:00 p.m. eastern time.  Contact us at 1-508-435-
9595 and 1-800-282-5008 or FAX 1-508-435-2373.

See us on the World Wide Web: http://www.ctc-control.com/.

Your Comments
We welcome your suggestions and comments about this or any other
Control Tech document.  Comment forms are in the file called
BUGRPT.WRI, which was installed in the QSWIN21 directory during
your Quickstep installation.  You can also email comments to
techpubs@control.com.
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Overview

The DeviceNet Configurator is a powerful program that gives you the
ability to actively configure your DeviceNet network from a “live”
network with DeviceNet Monitor or build a configuration offline with
the standard set of Configurator tools.

In Monitor mode, your physical network connections must already be
established. The scanner must first be identified, followed by each
device on the network. You must know a device’s MACID before the
device can be identified on the network. After connections are estab-
lished, you can then verify the types of messaging supported by each
device.

In offline mode, you can import EDS files for all devices you want to
add to your network or you can build a configuration from scratch by
using the series of buttons accessible from the main screen. Network
connections are not required in offline mode. You merely build your
configuration, save it to a configuration (.DNC) file, and download it to
the 2716D module where it is stored in flash memory.
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Getting Started

Install the DeviceNet Configurator software from Windows as follows:

1. Insert the CD into the CD-ROM drive; the installer program
(autorun.exe) launches automatically. Press NEXT and the Select
Components screen displays.

2. Select the application components that you want to install on your
PC, then press NEXT. Press NEXT on the next several screens until
the Choose Destination Location screen displays.

3. Select a destination folder for your files.

4. After pressing NEXT several times, the installer will install the
proper system components.

5. Press FINISH on the next two screens to complete the installation.

Installation
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The following illustration shows the DeviceNet Configurator’s main
window and describes the different parts of the window.

DeviceNet Configurator Main Screen - Overview

Title Bar - Displays the
application name and the
name of your configuration file.

Menu Bar - Contains the
File, Configuration, View
and Help menus.

Toolbar - Gives you
access to the most
common tools used in
the Configurator.

Devices on Network window - Lists
all the configured DeviceNet devices
along with their MACID. The master
device is displayed at the top and all
slave devices are shown indented.

Status Bar - Lists the last completed
activity, the current date, and the
current time.

Device Buttons -
Use these buttons
to add a scanner and
DeviceNet devices or
to delete devices from
the network.

Messaging Setup Buttons -
Use these buttons to add
links, map I/O points, set
up parameters, or specify
explicit messages.
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The Toolbar appears directly below the menu bar at the top of the
Configurator’s main screen. To hide or display the toolbar, choose
Toolbar from the View menu. The main screen toolbar is illustrated
below along with a description of each icon.

Configurator Toolbar - Main Screen

New - Deletes the currently loaded configuration and starts a new session. If you have a
configuration file open and have pressed this icon, the program will prompt you to save changes
to this file.

Open - Opens an existing DeviceNet configuration (.DNC) file.

Save - Saves new configuration files or saves changes to existing configuration files.

Print - Prints out your configuration file.

Upload Configuration - Transfers a configuration file to the Configurator from the 2716D scanner
module.

Download Configuration - Transfers a configuration file from the Configurator to the 2716D
scanner module.

DeviceNet Monitor - Opens the DeviceNet monitor utility, which is used to scan the DeviceNet
network and retrieve configuration information from all connected devices.

Help - Launches online help for the DeviceNet Configurator program.
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The menu bar, which is illustrated below, appears directly below the
Configurator’s title bar at the top of the screen. The following section
contains a brief description of each menu.

File Menu
The File menu provides access to the most common file functions. You
can start a new configuration session, open existing configuration files,
save changes to configuration files, import a list of vendors, export a
symbol file to Quickstep, print out configuration files, and exit the
Configurator.

Configurator Menu Bar
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Configuration Menu
The Configuration menu allows you to download configuration files
from the Configurator to the 2716D module, upload configuration files
from the 2716D module to the Configurator, set up communications
between the module and your host PC, or access the DeviceNet
Monitor utility.

View Menu
The View menu allows you to toggle the toolbar and status bars on or
off and also provides access to the CTC DeviceNet home page at
http://www.ctc-control.com/devicenet.

Help Menu
The Help menu allows you to launch the Configurator’s online help file,
provides online help search capability, and gives information on the
program version and function.
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Opening Files

Opening a New Configuration File
To open a new DeviceNet configuration (.DNC) file:

Choose New from the File menu (shortcut, type CTRL + N) or choose
the New icon  on the main screen toolbar.

NOTE: New has no visible effect unless you have already started
building your configuration. If so, the system will prompt you to
save changes to your current configuration. If you don’t save
your file at this time, the program will delete your configuration
information.

Opening an Existing Configuration File
To open an existing DeviceNet configuration file:

1. Choose Open from the File menu (shortcut, type CTRL + O) or
choose the Open icon  on the main screen toolbar

2. The Open dialog box appears as shown below. Note that the File
name box initially displays the name of the most recently opened
file. Locate the desired file and open it by typing its name in the File
name box or by selecting it from the list of displayed files.

3. Press the Open button to open the file in the Configurator’s main
screen.



1-9

Control Technology Corporation proprietary. Reproduction or distribution forbidden.

Getting Started

You can save a new configuration file or save changes to existing files
by using the Save and Save As commands.

Saving New Configuration Files
To save a new configuration file:

1. Choose Save (shortcut, type CTRL + S) or Save As from the File
menu or press the Save icon  on the main screen toolbar.

The Save As dialog box appears as shown below.

2. Enter a name for the new file. Locate the directory you want to save
your files in, then select Save to save the file.

Saving Changes to Existing Configuration Files
To save changes to existing configuration files:

1. Choose Save (shortcut, type CTRL + S) from the File menu or press
the Save icon  on the main screen toolbar.

2. The program saves all changes made to the file since it was last
saved.

NOTE: If you want to assign a new name to the file, select Save As
from the File menu.

Saving Files
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Printing Files
To print out a configuration file:

1. Choose Print (shortcut, type CTRL + P) from the File menu or
select the Print icon  on the toolbar.

2. The Print Setup dialog box displays as shown below. You can set
the destination printer by pressing the Network button. In addition,
you can specify the paper size, page orientation, color, number of
copies, and other attributes that are dependent on the printer
selected.
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The configuration file lists all the attributes of the master and slave
devices such as:

• MACIDs for the master and all slave devices

• Baud rate for the scanner

• Device name, revision level, and manufacturer

• Parameter settings for all devices

• I/O message setup-includes items such as message type, scan and
inhibit times (if applicable) and so forth

• I/O mapping information-includes items such as data type, starting
bytes, significant bits, and so forth

• Explicit messages-contains specific setup information for explicit
messaging

NOTES: You cannot view the configuration file except by printing it. A
typical example of a printed file is shown on the following page.

Downloading a blank configuration file to the 2716D disables
scanning and allows you to switch from Master mode to Slave
mode. A blank configuration file only defines the scanner and
does not define any devices.

Configuration Files
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Typical Printed Configuration File

Configuration Files

[CTC Scanner]

MACid = 63
Baud =500Kbs

[Devices]

MACid Revision Product Vendor

1 1.1 CTC 2716D DeviceNet Control Technology Corporation
2 1.100 DeviceNet NIU GE Fanuc Automation
12 3.0 BECKHOFF BK5200 V03.00 Beckhoff Industrie Elektronik

[Parameters]

MACid Number Data Bits Data Type Control   Path Value

1 8 2 2 0  [6] 20 50 24 03 30 01 13005
1 9 1 8 0  [6] 20 50 24 03 30 02 1

[IO Links]

MACId Link Scan Inhibit Input Size Output Size Input Path Output Path
1 Poll 50 1000 8:64 8:64 [0] [0]
I Strobe 100 1000 4:32 0:0 [0] [0]
2 Poll 50 1000 4:32 4:32 [0] [0]
12 Poll 50 1000 11:88 6:48 [0] [0]

[I0 Mappings]

MACid Link Data Type StartByte DataBits StartBit SigBits Address Length         Min Max Name

1 Poll Digin 1 1 1 1 129 16 0 1 CTC Ins
1 Poll DigOut 1 1 1 1 129 16 0 1 CTC Outs
1 Strobe DigIn 1 1 1 1 185 32 0 1 CTC Strobe
2 Poll DigIn 3 16 1 1 65 16 0 1 GE Ins
2 Poll DigOut 3 16 1 1 65 16 0 1 GE Outs
12 Poll Digin 1 8 1 1 89 8 0 1 Beck Counter Ins
12 Poll Digin 10 8 1 1 81 8 0 1 BeckIns
12 Poll AnalIn 2 16 1 16 17 4 0 0 Beck Counters/Analog Ins
12 Poll DigOut 1 1 1 1 145 40 0 1 Beck Counter Control
12 Poll DigOut 6 8 1 1 81 8 0 1 Beck Digital Outs

[Explicit Messages]

There are no Explicit message settings.
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The Communications Setup box is used to configure the connection
between the Configurator and the 2716D DeviceNet module. From this
dialog box, you can specify a connection type, set the communcations
port, define the host and target nodes or IP address, and set a
communications timeout.

To configure communcations, proceed as follows:

1. Select Communications Setup from the Configuration menu.
The Communications Setup dialog box appears as shown below.

2. Click the arrow on the right side of the Connection Type field to
display the applicable connection type. This field establishes the
network connection type to the 2716D module.

NOTE: All serial communications are with user-selected baud rate, NO
parity, 8 Data Bits, and 1 Stop Bit.

Communications Setup
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3. Specify the communications port (COM1 through COM8) on the
back of your PC by typing it in the COM Port field.

4. Click the arrow on the right side of the BAUD Rate field to display
a list of baud rates. This field sets the baud rate for your connection.
Baud rate selections from 300 to 38,400 are available. Although the
baud rate is selectable, some controllers have a fixed baud rate.
Refer to your controller’s installation guide for configuration
specifications.

NOTE: The COM Port and Baud Rate fields are only available for
serial connections.

5. Specify the network node address (if applicable) of the host com-
puter running the Configurator program by typing it in the Host
Node field.

6. Specify the network node address (if applicable) of the 2716D
module by typing it in the Target Node field.

NOTE: The Host Node and Target Node fields are only available for
CTCnet connections.

Communications Setup
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7. Specify the IP address (if applicable) for the connection by typing it
in the IP Address field.

NOTE: The IP Address field is only available for UDP or TCP
connections.

8. Enter a delay time in milliseconds by typing it in the Timeout (ms)
field. This value is the amount of time elapsed before a communica-
tions failure is reported. The default value is 1000 milliseconds
(1 second).

NOTE: Some messages have fixed timeouts that may override this
setting.

9. Select Ok when you have finished making your selections.
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Importing the ODVA Vendor List
The Import ODVA Vendor List command (located on the File menu)
allows you to import a copy of the ODVA’s DeviceNet vendor list in
Excel spreadsheet format. This information is then added to the
Configurator’s database and is accessible through the DeviceNet
Device Selection screen. To import the vendor list:

NOTE: You must have Excel installed on your PC to import the vendor
list.

1. Select Import ODVA Vendor List from the File menu.

2. The Open dialog box appears as shown below. Locate the
vendor.xls file and open it by typing its name in the File name
box or by selecting it from the list of displayed files.

3. Press the Open button; the file opens up in Microsoft Excel. The
spreadsheet displays behind the Configurator’s main screen. Once
the file is imported, Excel is closed down and the Configurator tells
you that the vendor list is imported.
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Exporting Symbols

The Export Symbols command (located on the File menu) is used to
export symbol files into Quickstep. When you configure your devices,
you can assign I/O points and symbolic names. This information is part
of the configuration (.DNC) file. Invoking this command extracts this
information and saves it to a compatible Quickstep symbol (.sym)
format. To export symbol information:

1. Select Export Symbols from the File menu.

2. The Save As dialog box appears as shown below. Note that the
File name box initially displays the name of the currently loaded
configuration file.



1-18

Control Technology Corporation proprietary. Reproduction or distribution forbidden.

DeviceNet Configurator User Guide

3. Enter a name for the symbol file or re-use the existing name.

4. Locate the directory you want to save your files in, then press the
Save button to save the file in Quickstep’s symbol (.sym) format.
You can now load this file into Quickstep’s symbol browser. For
example, if you map digital inputs 17-22 and then export them as a
symbol file, you can open the file in the symbol browser as shown
below.
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This section describes how to add a scanner to your configuration file.

NOTES: All other buttons remain inactive until you’ve added a scanner.

You can also add a scanner from the DeviceNet Monitor
window. For more information, refer to Chapter 3, DeviceNet
Monitor.

This procedure assumes that the main Configurator screen is
displayed on your PC.

1. Press the Add Scanner button. The DeviceNet Master Address
window displays as shown below.

2. Type a master MACID between 0-63 in the Enter Master MACID
field.

3. Select a baud rate (default rate is 125 Kbs) from the Select
BAUD Rate field.

Adding a Scanner
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4. Press Ok. The CTC scanner is listed in the Devices on Network
window along with its node number as shown below.
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This section describes how to add a device to your configuration.

1. Press the Add Device button. The DeviceNet Device Selection
window displays as shown below.

2. Select a vendor from the list of companies provided in the Select
Vendor window by clicking once on a vendor name. This window
displays a scrollable list of DeviceNet vendors.

3. Select a device type from the Select Device window. This window
displays all devices for a specific vendor. Select a device by clicking
once on the device name.

Adding a Device with the Configurator’s Database
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NOTES: Devices do not appear in the Select Device window until they
are part of the Configurator’s database.

Devices may appear multiple times in the Configurator’s
database. This occurs when different versions of an EDS file
have been imported into the database. Be certain that the
version number or revision for the selected device matches
your actual device before adding the device with the Add
Device to Network button. If the revision number is more
recent than your physical device, it may contain parameters
that aren’t supported by the device.

4. Type a device MACID between 0-63 in the Device MACID field. If
the ID is already assigned to another device, the Configurator will
prompt you to enter a different number.

NOTES: Devices often have DIP switches that are used to set the
MACID and/or the baud rate. If these hardware settings are
valid, then they override any software settings on the device.
Devices without switches may also be set through Explicit
messages.

The 2716D has rotary switches that normally have priority over
any software settings. However, if the baud rate is set to 3 or
the MACID is greater than 63, then the switch settings are
ignored and the software settings (set by explicit messages)
take priority. If both hardware and software settings are invalid,
then the baud rate defaults to 125 kBd and the MACID defaults
to 63.

Make sure that the MACID entered through the Device MACID
field matches the device’s active settings (hardware or soft-
ware). If you assign a MACID to the 2716D with this field and
the ID differs from the current card settings, then scanning will
not occur and the 2716D will only operate as a slave instead of
both as a slave and a scanner.

The vendor code, product code, product type, and revision are
automatically filled in when you import an EDS file or select a
device from the Configurator’s existing database. You cannot
enter this information directly since these boxes are
unavailable.
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5. Press the Add Device to Network button to add the device to your
DeviceNet network. The program verifies that the device has been
added and returns to the main screen, where it displays a device icon
as part of the DeviceNet configuration (see the illustration below).

Adding a Device with the Configurator’s Database
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Adding a Device by Importing an EDS File

This section describes how to add a device to your configuration by
using an EDS file.

NOTE: Make sure that the EDS file you are importing matches the
software version supported by the device. If you have down-
loaded the latest version of an EDS file from a device vendor’s
web site, it may contain parameters that are not supported by
the device.

1. Press the Add Device button. The DeviceNet Device Selection
window displays as shown on the previous page.

2. Press the Import Device EDS File button to import a device’s EDS
file into your Configurator’s database.

NOTE: Once a file is added to the database, the device is associated
with a specific vendor and appears in the Select Device
window.

3. The Open screen displays as shown below. Locate the desired file
and open it by typing its name in the File name box or by selecting
it from the list of displayed files.
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4. Press the Open button or the Enter key. The Import EDS File
dialog box appears as shown below.

5. Press the Import button to import the EDS file into the
Configurator’s database. The program returns to the
DeviceNet Device Selection window.

6. Follow steps 2 through 5 from the Adding Devices with the
Configurator’s Database procedure to add the device to your
DeviceNet network.

Deleting a Device
This button deletes a device from your DeviceNet configuration. Select
a device from the Devices on Network window by clicking on it once
with the mouse. Press the Delete Device button to delete the device.

Adding a Device by Importing an EDS File
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The DeviceNet Links screen summarizes all I/O connections for a
particular device on the DeviceNet network and provides access to the
Device IO Setup screen, which is used to configure I/O
communications between the 2716D module and devices out on the
network.

To create an I/O link:

1. Select a device from the list displayed in the Devices on Network
window (main Configurator screen).

2. Press the Link Setup button; the DeviceNet Links screen
displays. The example below shows a link that has already been
created on the I/O setup screen.

3. Add a new link by pressing the Add Link button; the Device I/O
Setup screen displays as shown on the next page.

Creating I/O Links
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Creating I/O Links

 NOTES: This procedure assumes that the I/O Setup fields are empty,
which means there is no EDS file for the device or the EDS file
is incomplete.

If the I/O Setup fields are filled in by the EDS files (as shown
above), you can still change their values. If these values are
changed to the incorrect number, you may get strange results.

Record lengths (size of an I/O message) for a device may
depend on its configuration. Check the device’s documentation
or the DeviceNet Monitor window to ensure that the record
lengths imported with its EDS file are correct for the configura-
tion in use. Some EDS files do not contain this information, so
this data must be entered manually.

Producers and consumers are imported into the Configurator
as part of an EDS file and provide a way to have record lengths
of different sizes. For example, Output 1 and Output 2 shown
above may each have a different record length. The Produc-
ers window lists the responses produced by the device and
sent to the scanner. The Consumers window lists the requests
produced by the scanner and sent to the device. Neither of
these fields is user-configurable.
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4. Specify the number of input bytes in the Input Bytes field. This
field lists the number of input bytes in the message sent by the
producer. For example, when the device sends out a message to the
scanner, it will contain the specified number of input bytes.

NOTE: Input bytes consist of data bits and status bits. The data bits
are specified in the Input Bits field.

5. Specify the number of input bits in the Input Bits field. This field
lists the number of data bits in the message sent by the producer. For
example, when the device sends a message to the scanner, it will
contain the specified number of input bits.

6. Specify the number of output bytes in the Output Bytes field. This
field lists the number of output bytes in the message sent by the
consumer. For example, when the scanner sends a message to the
device, it will contain the specified number of output bytes.

NOTE: Output bytes consist of data bits and status bits. The data bits
are specified in the Output Bits field.

7. Specify the number of output bits in the Output Bits field. This
field lists the number of data bits in the message sent by the con-
sumer. For example, when the scanner sends a message to the
device, it will contain the specified number of output bits.

8. Select the type of messaging you require from the I/O Connection
Type field. This field allows you to choose between Poll, Strobe,
COS, or Cyclic messages.

NOTE: The link types listed above are not necessarily supported by a
device. Selecting an invalid link type will result in a configura-
tion failure.

9. Specify the scan time in the Scan Time field. This is the amount of
time that the scanner will scan for a message from a particular
device. Refer to the Theory of Operation section in the 2716D
Installation Guide for details on setting an appropriate scan time.
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10. Set an inhibit time in the Inhibit Time field. This is the amount of
time that a device must maintain a change of state (COS) condition.
This allows for debounce conditions where a set of contacts closes
or opens and “bounces” between states before settling down to one
value. During the inhibit time, change of state values are ignored
until the inhibit time has elapsed.

NOTE: The Inhibit Time field is only active for COS and Cyclic
messages.

11. Check the Suppress ACK (Acknowledgment) checkbox to
suppress acknowledgment messages from the scanner for both
COS and Cyclic connections. For example, when a device changes
state and sends out a COS message to the scanner, it may expect an
acknowledgment from the scanner. In cases where the device is
continuously changing state, it makes sense to suppress this
acknowledgment to avoid bogging down the network with
unnecessary traffic.

12. Press the Ok button to add the link to your configuration. The
program returns to the DeviceNet Links screen.

Additional Notes
The DeviceNet Links screen also provides the following options:

• Deleting Links - Delete an existing link by selecting the link name
in the Links window and then pressing the Delete Link button.

• Editing Links - Edit an existing link by selecting the link name in
the Links window and then pressing the Edit Link button; the
Device IO Setup screen displays. You can then change the
applicable link information.

Creating I/O Links
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The DeviceNet IO Mapping screen summarizes all maps for a
particular device and provides access to the Device IO Map screen,
which is then used to map the data transferred between the controller,
the 2716D module, and the specified device. To map a connection:

1. Select a device from the list displayed in the Devices on Network
window (main Configurator screen).

2. Press the IO Map Setup button; the DeviceNet IO Mapping screen
displays.

3. Add a new map by pressing the Add Mapping button; the Device
IO Map screen displays as shown on the next page.

NOTE: The information created on the Device I/O Map screen can be
exported as a symbol file and opened in Quickstep. Refer to
the Exporting Symbols section in Chapter 1, Getting Started for
more information.

Mapping I/O Points
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Mapping I/O Points

NOTE: The four Input Size and Output Size fields are not
user-configurable and are filled with the values that
were entered on the Device IO Setup screen.

 4. Choose a link type from the Select Link Type pull-down menu.
This menu allows you to select from links that were added through
the Device I/O Setup screen. For example, if you added a poll
connection and a COS connection, then these two choices are
available in the selection menu.

5. Choose a data type from the Select Data Type pull-down menu.
This menu allows you to select analog I/O, digital I/O, register
reads, and register writes. For each connection, you must specify
an input and output map.

6. Set the starting byte for your link in the Starting Byte field.
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7. Set the number of data bits in the Data Bits field. This sets the
length of an individual I/O point such as a digital I/O point, which
has 1 data bit.

NOTE: I/O addressing must be done in blocks of 8 bits, or 1 byte.
Each block of 8 inputs or outputs must either be mapped to a
single device or remain unmapped. For example, if you map a
digital I/O point to address 17, then the remaining 7 bits may
not be used for any other device. In addition, mappings must
start with an I/O number that is a multiple of 8 plus 1
(1,9,17,25, etc.).

8. Set the starting bit for your link in the Starting Bit field. This tells a
device where to look in a message for the start of your data.

NOTE: Digital I/O always have 1 significant bit and are 1 bit in length.

9. Set the number of significant bits for your connection in the
Significant Bits field. You may need to check the documentation
for your device to determine this information.

10. Set the starting address for your connection in the CTC Address
field.

NOTE: CTC recommends that you mount the 2716D module into the
right-hand most slot of your controller and assign I/O ad-
dresses that do not conflict with local I/O assignments. For
example, suppose you have a 2203 (16 inputs, 16 outputs)
module installed in your controller as input number 8. When
the controller powers up, it creates a resource map of all the
installed modules. This map allows Quickstep to know what its
resources are as well as how to address them. The controller
only checks DeviceNet I/O assignments if it hasn’t already
found these addresses on another board. Therefore, since
input 8 is already assigned to the 2203 module, it will be
masked by the local I/O map and not added to the resource
map.

11. Set the number of I/O points for your connection in the IO Points
field.
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12. Set any optional minimum and maximum scale values in the
Optional Scale Values Minimum Value and Maximum Value
fields. This field sets the minimum and maximum values for your
connection. For digital I/O, the minimum is 0 and the maximum is 1.
For analog I/O, these values will vary according to your application
and device type.

13. Specify a map name in the Map Name field. This field can be
used to describe a device’s manufacturer and map type and appears
in the I/O Mappings window after you have exited from the setup
screen.

14. Press the Ok button to add the map to your configuration. The
program returns to the DeviceNet IO Mapping screen.

Additional Notes
The DeviceNet IO Mapping screen also provides the following options:

• Deleting Maps - Delete an existing map by selecting the map
name in the IO Mappings window and then pressing the Delete
Mapping button.

• Editing Maps - Edit an existing map by selecting the map name in
the IO Mappings window and then pressing the Edit Mapping
button; the Device IO Map screen displays. You can then change
the applicable mapping information.

Mapping I/O Points
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Setting Parameters
Parameters are configuration items that are stored within the device and
are generally part of a device’s EDS file. These items can be set or
verified during system initialization to ensure that the DeviceNet module
is in a known state and is configured for a particular application. For
example, if the 2716D is operating in slave mode, parameters are used to
verify that the correct registers are being read in response to a Poll
commmand. Once this information is processed by a master device and
the network is operational, then the parameters are no longer required.

Parameters may also be parameter objects. These are a set of objects
inside a device that are related to the parameters in an EDS file. One
required attribute is the parameter’s value. Other attributes may provide
a name, description, type and range of data, etc. If the object is com-
pletely defined, it is possible to extract the information and use it to
build your configuration like you would with an EDS file.

NOTES: Check the device’s documentation for more information on
parameters and their assigned values.

Many of the parameter fields are filled in by the EDS file and
are not user-configurable.

If parameters are not specified in an EDS file, you can use
Explicit Messaging to achieve the same result. Refer to the
Explicit Messages section for more information.

The DeviceNet Parameters screen summarizes all parameters for a
particular device and provides access to the Device Parameters screen,
which is then used to specify parameter settings. Set parameters as
follows:

1. Select a device from the list displayed in the Devices on Network
window (main Configurator screen).

2. Press the Parameter Setup button; the DeviceNet Parameters
screen displays as shown on the next page.
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Setting Parameters

3. Add a new parameter by pressing the Add Parameter button; the
Device Parameters screen displays as shown below.

4. Select a parameter from the Parameters list. This list is filled in by
a device’s EDS file if one exists and is a list of a device’s operating
parameters.
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5. Select a parameter. The Select Value list displays the possible
values you can assign to a parameter. If no selection information is
supplied by the EDS file, then Select Value is replaced by the Enter
Value list and you are prompted to type in a value.

NOTES: The Path Size field displays the number of bytes in the path
(address) of a specific parameter and the Path field displays
the hexadecimal location of where a parameter is stored inside
a device.

The Minimum and Maximum fields display the minimum and
maximum acceptable values for a parameter.

These fields are not user-configurable.

6. Select the following checkboxes for additional control over your
parameter configuration:

• Update Value - Instructs the scanner to read in the value of a
parameter. The value is compared to the specified parameter value.
If the actual value is different, the scanner tries to write the new
value to the device. The scanner will perform different actions based
on whether the Fail on Error checkbox is also selected.

• Fail on Error - After the scanner determines that a parameter has
changed, it tries to write the new value to the intended device. If it
cannot update this information and the Fail on Error box is
checked, it checks the value a second time. If it matches, the com-
munication is accepted. If the value is different, then the configura-
tion of that device has presumably failed and the module will not be
added to the scanner’s active configuration. The module is then
disconnected from the network and I/O is not updated.

7. Press the Ok button to add the parameter to your configuration. The
program returns to the DeviceNet Parameters screen.
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Additional Notes
The DeviceNet Parameters screen also provides the following options:

• Deleting Parameters - Delete an existing parameter by selecting
the parameter name in the Parameters window and then pressing
the Delete Parameter button.

• Editing Parameters - Edit an existing parameter by selecting the
parameter name in the Parameters window and then pressing the
Edit Parameter button; the Device Parameters screen displays.
You can then change the applicable parameter specifications.

Setting Parameters
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Explicit Messages
Explicit messages are used to transmit and receive specific information
between the scanner module and a device. For example, if you want to
slow down a motor that is out on the network, you can reduce the
velocity by sending it a message.

The DeviceNet Explicit Messages screen summarizes all explicit
messages for a particular device and provides access to the Explicit
Messages screen, which is then used to build explicit messages.
Specify an explicit message as follows:

1. Select a device from the list displayed in the Devices on Network
window (main Configurator screen).

2. Press the Explicit Setup button; the DeviceNet Explicit
Messages screen displays as shown below.

3. Create a new explicit message by pressing the Add Message button;
the Explicit Messages screen displays as shown on the next page.
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Explicit Messages

NOTE: Refer to your device’s documentation for specific information
on items such as service codes and class, instance, and
attribute IDs.

4. Select a service code from the Select Service Code list. The Service
Code list is a standard list of codes for all devices that is used to
build messages. The first three codes (Get_Attribute_Single,
Set_Attribute_Single, Reset) are the most commonly used codes.

5. Specify a class ID by typing it in the Enter Class ID field. The
Class ID is a category that defines subdivisions of the functionality
of a device. For example, a device might perform some sort of
operation on the data it receives. This is an example of an applica-
tion class (or object).
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6. Specify an instance ID by typing it in the Enter Instance ID field.
The Instance ID might be used to define different categories of the
same class in situations where the same set of functions is required
but for different reasons or in different ways. Every instance shares
a common data structure for the characteristics but has its own set of
this data and the individual values in the data structure are often
different between the instances. Each instance can then have differ-
ent operating characteristics.

7. Specify an attribute ID by typing it in the Enter Attribute ID field.
The Attribute ID controls all behavioral characteristics for each
instance. Each instance can then have its own unique set of the same
attributes.

8. Type an explicit message in the Enter Explicit Message window.
The Enter Explicit Message window can be used to enter
messages in hexadecimal notation.

9. Specify the byte length for your class and instance by clicking on
one of the Class/Instance Byte Length buttons. This series of radio
buttons defines the byte length for classes and instances. For
example, DeviceNet 8/8 indicates that the class ID is one byte in
length and the instance ID is one byte in length. Byte length is
specific to a device.

10. Press either the Insert Variable or Format Response buttons to
insert a variable into your explicit message or to specify a register
location within the controller for the contents of an explicit message.
The Explicit Variable Format or the Explicit Response Format
screens display as shown below. The Enter Register Number field
is used to enter the register number for this information and the
Output Value radio buttons control the byte length for this data.
Press Ok to exit from this screen.
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11. Check the Configuration checkbox if you want the scanner module
to treat the explicit message like a configuration message that is
only sent once.

12. Specify a symbolic name for the explicit message in the Symbolic
Name field. This field can be used to describe the contents of the
explicit message. Once this information is created, you can export it
as part of a symbol file and open it in Quickstep. See the Exporting
Symbols section in Chapter 1 for more information.

13. Press the Ok button to add the explicit message to your configura-
tion. The program returns to the DeviceNet Explicit Messages
screen.

Additional Notes
The DeviceNet Explicit Messages screen also provides the following
options:

• Deleting Explicit Messages- Delete an existing message by select-
ing the message name in the Explicit Messages window and then
pressing the Delete Message button.

• Editing Parameters - Edit an existing message by selecting the
message name in the Explicit Messages window and then pressing
the Edit Message button; the Explicit Messages screen displays.
You can then change the applicable message information.

Explicit Messages
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DeviceNet Monitor is used to actively scan the DeviceNet network and
retrieve configuration information from all connected devices. To launch
DeviceNet Monitor, do one of the following:

• Select Monitor from the Configuration menu

• Select the DeviceNet Monitor icon  on the main screen toolbar

The DeviceNet Monitor window displays as shown below.

Overview
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The Monitor Toolbar appears across the top of the DeviceNet Monitor
window. The toolbar is illustrated below along with a description of
each icon.

NOTE: Although the illustration above shows all the buttons enabled,
this does not occur until after the first device is added to the
network.

Identify Device button - Enter a device’s MACID when the program prompts you for this value.
The network scans for that device and returns information to the Monitor’s main window.

Setup Poll Link button - Sets up a poll connection for the currently enabled device. If poll
commands are not supported by that device, the program will display a message telling you that
poll messaging is not supported.

Setup Bit Strobe Link button - Sets up a bit strobe connection for the currently enabled device. If
bit strobe commands are not supported by that device, the program will display a message telling
you that bit strobe messaging is not supported.

Setup Cyclic Link button - Sets up a cyclic connection for the currently enabled device. If cyclic
commands are not supported by that device, the program will display a message telling you that
cyclic messaging is not supported.

Setup Explicit Message Link button - Sets up an explicit message connection for the currently
enabled device.

Monitor Toolbar

Identify Scanner button - Scans the network for the master device and displays the scanner’s
MACID and baud rate. You can also clear the Monitor window by pressing this button.

Setup Change of State Link button - Sets up a change of state connection for the currently
enabled device. If change of state commands are not supported by that device, the program
will display a message telling you that change of state messaging is not supported.
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Execute Link Command button - Execute a link command and sends a message. You press this
button after verifying the message types supported by a device. The Message Data screen
displays for all message types except explicit messaging. For explicit messages, all the fields in
the top section are enabled.

Enable/Disable Network Scan button - Turns on or turns off network scanning.

Enable/Disable Message Logging button - Enables and disables network logging and provides
setup for specific message groups by group ID, message IDs, and MACIDs.

Get Message Log button - Displays a message log that lists a time stamp, message ID number,
and the hexadecimal equivalent of the message being transmitted or received.

Configure Event Logging button - Contains events such as controller communications, scanner
operational messages, and DeviceNet slave operations. Once this is configured, the event log
displays the checked items after the Get Event Log Update button is pressed.

Get Event Log Update button - Displays an event log based on the items selected from the Event
Log Setup screen. Event logs are often used for troubleshooting purposes.

Help button - Displays help on using the DeviceNet Monitor utility.

Monitor Toolbar
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This section describes how to build your configuration by using a
DeviceNet network.

After launching the DeviceNet Monitor utility, proceed as follows:

NOTE: You should not try to monitor the network while it’s in active
scan mode. Stop the scan by pressing the Enable/Disable
Network Scan button.

1. Identify the scanner on your network by pressing the Identify
Scanner button. The utility returns the scanner’s MACID and baud
rate as shown below.

NOTE: You can also use the Identify Scanner button to clear the
screen of all messages.

2. Press the Add Scanner button to add the scanner to your
configuration.

DeviceNet Monitor- Network Configuration
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3. Identify the device on your network by pressing the Identify Device
button. The utility returns the type of information shown below.

NOTE: Once the device has been identified, all the messaging buttons
become enabled.

4. Press the Add Device button to add the device to your
configuration.

DeviceNet Monitor - Network Configuration
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5. Determine the type of messaging that is supported by the device by
pressing any of the following buttons:

• Setup Poll Link

• Setup Bit Strobe Link

• Setup Change of State Link

• Setup Cyclic Link

If the message type is not supported, the Configurator will alert you.
For example, let’s suppose we want to establish a poll link with a
Beckhoff BK5200 bus coupler. After pressing the Setup Poll Link
button, the display looks similar to the figure below. Note that the
message size is also provided (6 input bytes, 6 output bytes).
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6. Press the Add IO Msg button once a successful connection has been
established. This button provides access to the Device IO Setup
screen, where you can configure messaging for a particular device.
Once you have done so, the program returns to the Monitor utility.

NOTE: For more information on adding I/O messages, refer to
Creating I/O Links in Chapter 2.

7. Press the Execute Link Command button to send a message once
you’ve verified the types of messages that are supported by a device.
The Message Data screen displays as shown below for all message
types except explicit messages. For explicit messages, all the fields
in the top section are enabled.

NOTE: For more information on explicit messages, refer to Explicit
Messages in Chapter 2.

DeviceNet Monitor - Network Configuration
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8. Type your message in the Enter Message Data field, then press Ok
to send the message. The DeviceNet Monitor screen appears as
shown below.

In this example, the four least significant bits in each message
correspond to four digital outputs on the device. This is verified by
the messages transmitted in the figure above. In the first four
messages, the four bits are turned on and off one at a time
(1, 2, 4, 8). In the fifth message, the outputs are all turned on
simultaneously (F), and the sixth message turns all outputs off (0).



3-10

Control Technology Corporation proprietary. Reproduction or distribution forbidden.

DeviceNet Configurator User Guide

9. Configure message logging by pressing the Configure Message
Logging button. The Message Log Setup screen displays as shown
below.

This screen provides the following options:

• Logging Message Traffic - You can log traffic for a single device by
specifying its MACID (Enter Device Address) or for several devices
by specifying various types of IDs (group, message, MAC ID
fields).

• Group ID - Select from the four DeviceNet message groups. Group 1
messages are the highest priority and Group 4 messages are the
lowest priority. If you select Any, then all four group types will be
logged.

DeviceNet Monitor - Network Configuration
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• Msg ID - Select from a series of message IDs for each DeviceNet
message group. The IDs change depending on what is selected in the
Group ID field. This field defaults to Any when Any is selected in
the Group ID field.

• Match/Mask Pairs - This window displays a list of hexadecimal
match/mask pairs for each set of messages you want to log. These
numbers are automatically generated by the Configurator and
depend on the selections you make in the Group ID, Msg ID, and
MACID fields. You can add or delete match/mask pairs by using
 the Add Pair and Delete Pair buttons.

• Clear Message Log - Check this box to clear out any messages
previously selected for logging and to log only newly selected
messages.

• Disable Message Logging - Check this box to disable message
logging.

Once you have specified all your logging options, press Ok to
accept the current message log configuration and return to the
Monitor screen.
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10. Press the Get Message Log button to display a message log similar
to the one shown below. The log lists a time stamp (clock ticks),
message ID number, and the hexadecimal equivalent of the message
being transmitted or received.

11. Configure event logging by pressing the Configure Event Logging
button. The Event Log Setup screen displays as shown below. You
can choose items such as controller communications, scanner
operational messages, and CAN protocol messages.

DeviceNet Monitor - Network Configuration
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12. Select the items you want to see in the event log, then press Ok to
accept these settings.

NOTE: The setup screen’s default setting has all the boxes checked
off. You can specify the settings you require, and the event log
will capture the requested information, but if you return to the
setup screen, your previous settings are ignored and all boxes
are selected.

13. Press the Get Event Log Update button to display a log similar to
the one displayed on the next page. The log will display whatever
items you have specified in the Event Log Setup screen.
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 NOTE: When you are finished monitoring the network, make sure you
resume network scanning by pressing the Enable/Disable
Network Scan button.

14. Once you are satisfied with your configuration setup, exit from
DeviceNet Monitor by pressing the Exit button. The program
returns you to the main Configurator screen.

NOTE: The scanner and devices that were added through DeviceNet
Monitor are displayed in the Devices on Network window.

15. Save your configuration file as described in the Saving Files section
in Chapter 1.

DeviceNet Monitor - Network Configuration
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